
Overview
This chapter presents a series of basic tutorials that demonstrate various
HVE-2D techniques and capabilities. The purpose of these tutorials is to
provide a solid grasp of the fundamentals of using HVE-2D, and to help the
user become as efficient as possible. This is accomplished through a series of
high-level, task-oriented procedures using a step-by-step approach.

While this tutorial explores many of HVE-2D’s important features, it does not
provide detailed explanations. For these details, the tutorial refers to specific
chapters, and the user should refer to those chapters when necessary.
Additional information, including a comprehensive index, may be found in the
Appendix.

+ NOTE: In addition to this tutorial, every EDC physics

model has a Program Manual that includes a

comprehensive tutorial specific to that physics model.

Manuals from 3rd party vendors typically include a

tutorial as well.
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The Tutorial is divided into four individual lessons:

• Lesson 1 - Navigating in HVE-2D - This lesson is shows
techniques that promote efficiency. The user learns how to move
quickly within HVE-2D to perform fundamental tasks.

• Lesson 2 - Running a Simulation Model - This lesson shows
the best way to set up and execute HVE-2D compatible physics
models (reconstructions and simulations involving vehicle
dynamics).

• Lesson 3 - Combining Multiple Events - This lesson
explains how to merge two or more individual simulations into a
coherent and seamless sequence involving multiple vehicles.

• Lesson 4 - Creating a Video - This lesson provides a quick
and easy lesson describing how to create your first video.

Let’s begin with the first lesson.

Lesson 1 - Navigating in HVE-2D
Lesson 1 is a lesson in fundamentals, with an emphasis on efficiency. In this
lesson you will learn to perform the following fundamental tasks:

• Starting HVE-2D

• Learning About the Menu Bar

• Managing Dialogs and Viewers

• Choosing an Editor

• Using Dialogs

• Using Viewers

• Shutting Down HVE-2D

Do not skip this lesson! By spending time performing these tasks, you will be
able to navigate within HVE-2D more quickly, more efficiently and (perhaps
most important) more intuitively! You’ll be able to effortlessly view the action
from the desired viewpoint. You’ll be able to set up your viewers to gain
maximum efficiency and information from what HVE-2D is telling you. Put
simply, this lesson helps you get the most out of your HVE-2D system. Let’s
get started.

Starting HVE-2D

To start HVE-2D, use the Start, Programs cascade menu to select the HVE-2D
program menu and then the HVE-2D program icon, just as would start any other
program on your computer. After starting HVE-2D, the HVE-2D Menu Bar and
current HVE-2D Editor are displayed (in this case it is the Vehicle Editor), as
shown in Figure 32-1.
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+ NOTE: HVE-2D saves the current editor when you exit;

thus, the editor now displayed is the one you were using

when you last exited HVE-2D.

Learning About the Menu Bar

We will be using many terms throughout this (and other) tutorials. If you have
not worked with Windows before, many of these terms will be new to you. The
actions you will be performing will be new as well.

Let’s start off by identifying and experimenting with the components that
make up what is called the Menu Bar. Many of the functions accessed using
the menu option may also be selected by clicking on various toolbar buttons.
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Figure 32-1 The Desktop, after starting HVE-2D. HVE-2D has amain program window
with a Menu Bar, Tool Bar, integrated Event and Playback Controller, Viewer
Manipulators and Zoom Slider.



Menu Bar

A Menu Bar, shown in Figure 32-2, is common to all Window-type programs.
It contains the program’s fundamental options. In the case of HVE-2D, these
options are File, Edit, View, Mode, Set-up, 3D-Edit, Options and Help. Let’s
briefly explore these options:

â Click on File. The File menu is displayed. This menu provides

basic system operations, such as starting new cases, opening and

saving files, working with video, printing and exiting HVE-2D.

â Click on Edit. The Edit menu is displayed. This menu provides

operations that allow you to edit selected objects.

+ NOTE: No Edit menu options are currently available

because no object is selected. Other menus will also

have disabled options until the appropriate situation

allowing the use of the option is present.

â Click on View. The View menu options are displayed. This

menu provides operations that determine how you look at

simulations.

â Click on Mode. The Mode menu options are displayed. This

menu allows you to select which Editor you are currently

using, and also to add new or previous objects into the Editor

(e.g. Select Mode, Add, New or Previous).

â Click on Set-up. The Set-up menu options are displayed. This

menu allows you to enter inputs for setting up your simulation

or reconstruction events.

â Click on 3D-Edit. The 3D-Edit menu options are displayed.

This menu allows you to launch and close the 3D Editor while

in Environment mode, plus edit material attributes, colors and

textures or change manipulators while in the 3D Editor.
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Figure 32-2 Menu Bar. HVE-2D�s menu bar is very traditional, with File, Edit, View,
Mode, Set-up, 3D-Edit, Options and Help menu options. It also includes the Dialog
Control button (a), the Title Bar (b), theActive Objects List (c), theEvent Controller (d), the
Minimize and Maximize buttons (e), the Close button (f), and several toolbar buttons for
quick access to functions.

(a) (b) (e) (f)

(c) (d)



â Click on Options. The Options menu is displayed. This menu

provides several user-definable options and preferences.

â Click on Help. The Help menu is displayed. This menu

provides access to the various HVE-2D Help System options.

The Dialog Control button is located in the upper left corner of the Menu Bar
(see Figure 32-2 (a), above).

â Click on the Dialog Control icon. The dialog control options

are displayed. These options allow you to move the dialog,

change its size, minimize it (replace the dialog with a small

icon - handy if you’re not currently using the dialog), and

maximize it (make the dialog as large as possible).

All dialogs and viewers have a Dialog Control button.

The Menu Bar also includes the Title Bar. This component (b) displays the
current case title, followed by the current filename in parentheses. All dialogs
and viewers also have a Title Bar, and it has an important function:

â Click on the Title Bar and drag the mouse. The dialog (i.e., the
HVE-2D program window in this case) follows your mouse
cursor. This is a fundamental navigation task that allows you to
move dialogs and viewers anywhere you wish.

The Active Objects List is integrated into the Menu Bar. This component (c)
displays a drop-down list of active objects while in the Vehicle, Environment
and Event mode. By clicking the button on the right side of the list, the
complete list of objects is displayed. The current object is displayed in the
viewer. To add a new object to the list, click on the Add New Object button
(looks like a + sign) located two buttons to the left of the list on the toolbar. To
display the Information dialog for the current object, click on the Object Info
button (looks like a hand pointing) immediately to the left of the list on the
toolbar.
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Figure 32-3 Active Objects List drop-down display shown in Vehicle Mode.
Add New Object and Object Info toolbar buttons are located to the left of the
list.



The Event (and Playback) Controller is integrated directly into the Menu Bar.
Additional information displays used in conjunction with the Event Controller
are shown in Figure 32-4. These information displays are as follows:

• Current Simulation Frame - Displays the current frame of

simulation output. A frame is equivalent to one timestep of output.

• Max Simulation Time - Displays the selected Simulation Controls

Maximum Simulation Time termination condition.

• Simulation Timestep - Displays the integration timestep used for

typical vehicle trajectory calculations as set in Simulation Controls.

• Current Simulation Time - Displays the current timestep of the

complete event.

• Output Interval - Displays the timestep interval used for display

results as set in Simulation Controls.

The Event Controller Slider can be used to move forward or backward through
each simulation frame. This provides the user with an easy means to locate a
specific point in a simulation, without having to Play and Stop the simulation.

The Menu Bar includes Minimize and Maximize buttons, as shown in Figure
32-2 (e).

â Click on the Minimize button. The dialog disappears! Actually,
it turned into an icon and is displayed along the bottom of the
Windows desktop.

â Click on the HVE-2D icon. The current HVE-2D program
window is redisplayed.

â Click on the Maximize button. The Menu Bar fills the screen.
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Figure 32-4 Event Controller



+ NOTE: Using the Maximize button to maximize the
program window allows you to use the whole screen for
your work. Setting your display to 1024 x 768 or 1280 x
1024 resolution provides you with an even larger work
area.

â Click the Maximize button again (which is now the Restore
button). The dialog returns to its original size.

Finally, the Menu Bar (and all windows and dialogs) includes a dialog frame
that surrounds the dialog. The dialog frame has two functions:

â Click on the frame and drag the mouse. The dialog changes size.

Depending on where you click on the frame, the dialog changes size in the
direction you drag. If you click on the corner, it changes size in both directions.

â Click and drag on various parts of the dialog frame,
experimenting with this feature.

+ NOTE: Some dialogs cannot be resized.

The second function of clicking on the frame is that it raises the dialog to the
top of the display, a useful feature if the dialog is partially covered and you
need access to it. We’ll explore this use later in this tutorial.
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Viewers

Viewers are used to display objects. A typical viewer is shown in Figure 32-5.

Viewers have the same window manager components that were just explored
using the Menu Bar. In addition, viewers also have the following components:

• Viewer Mode Selector - This component, shown in Figure 32-5 (a),

allows the user to switch between Pick mode, used for choosing objects

in the viewer and performing an editing operation on that object, and

Manipulate mode, used for changing the view using direct

manipulation.

• Viewer Controls - These components include Viewer X and Y

translation thumb wheels, shown in Figure 32-5 (b), Dolly thumb

wheel, Figure 32-5 (c), and Zoom slider, Figure 32-5 (d).

These components will be explored later in this tutorial.

32 - 8

HVE-2D Lesson 1 - Navigating in HVE-2D

Figure 32-5 Typical Viewer. PickMode orManipulate Mode is selected by choosing the
arrow or hand, respectively, near the upper right edge of the viewer (a). TransX and
TransY thumb wheels (b) translate the object in the viewer along the viewer�s X and Y
axes, respectively. The Dolly thumb wheel (c) increases or decreases the size of the
object by moving the camera away from or towards the object. The Zoom slider (d)
increases or decreases the size of the object by reducing or increasing the viewer�s
included angle.

(b)

(a)

(c)
(d)



HVE-2D Mode Selector

The HVE-2D Mode Selector is integrated into the toolbar at the left hand side
of the Main Menu. As shown in Figure 32-6, the Mode Selector has five
buttons, as follows (left to right):

• Human Editor Button - Not available in HVE-2D

• Vehicle Editor Button - Displays the Vehicle Editor, placing

HVE-2D in Vehicle mode.

• Environment Editor Button - Displays the Environment Editor,

placing HVE-2D in Environment mode.

• Event Editor Button - Displays the Event Editor, placing HVE-2D

in Event mode.

• Playback Editor Button - Displays the Playback Editor, placing

HVE-2D in Playback mode.

Let’s get a little practice using the HVE-2D Mode Selector:

â Click on each button in the Mode Selector to display the

various HVE-2D editors.
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Figure 32-6 HVE-2D Mode Selector, located at the left
hand side of the toolbar. The Mode Selector is used to
switch between modes. The depressed button
appearance indicates the Vehicle Editor is currently
selected. (Note: Human Mode is disabled in HVE-2D)



Managing Dialogs and Viewers

Becoming an efficient HVE-2D user requires using a few simple, but
important, procedures. These procedures include:

• Arranging your desktop to allow you to be as efficient as possible

• Raising viewers and dialogs to the top of the desktop

• Minimizing windows to help improve system performance
(especially for viewers that must be rendered)

Minimizing Windows

While using HVE-2D, you may find your desktop becomes cluttered with
numerous data windows and viewers. This is especially true while using the
Playback Editor under the following two scenarios:

• You are working with a case that has multiple events and you have
created several output reports for each event.

• You are working with a case that has multiple Trajectory
Simulation windows and you are in the process of rendering the
Playback Window containing multiple Trajectory Simulation
events.

In these instances, you can minimize the window containing the report so it
takes less screen space.

+ NOTE: A minimized window maintains all the data

associated with it; minimizing simply removes the visual

representation of the window and replaces it with an icon.

+ NOTE: Minimized viewer windows are not rendered.

Because it takes time and computer resources to render

a window, minimizing viewer windows can significantly

speed up your work!

Let’s practice minimizing windows in the Playback Editor. Start by opening a
case:

â Click on File menu option and choose Open. The HVE-2D

File Selection dialog is displayed.

â Select HVE2DTutorLesson1EDC.hve and press OK.

â Choose No to the request to save the changes to the current case.

The selected case file is loaded into HVE-2D and the Vehicle Editor displays
the current vehicle in the Active Vehicles list and viewer.

â Choose Playback mode. The Playback Editor is displayed, as

shown in Figure 32-7.

â Click on the Traj Sim window to bring it to the top of the desktop.
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â Click on the Dialog Control button and choose Minimize. The

Traj Sim window is turned into an icon as shown in Figure 32-8.

32 - 11

Lesson 1 - Navigating in HVE-2D HVE-2D Tutorial

T
U

T
O

R
IA

L

Figure 32-7 Playback Editor with multiple reports. In this case, the
numerous reports make it difficult to manage the desktop, so we�ll
iconify the Traj Sim.

Figure 32-8 Playback Editor with multiple reports. This case differs
from Figure 32-7, above, in that one of the report windows has been
iconified (note the HVE-2D Traj Sim icon is displayed along the bottom
of the desktop).



Choosing an Editor

HVE-2D is designed around five fundamental editors. These editors are:

• Human Editor - Not available in HVE-2D

• Vehicle Editor - Used for selecting and editing vehicles

• Environment Editor - Used for selecting and editing the
environment

• Event Editor - Used for setting up and executing reconstruction
and simulation models

• Playback Editor - Used for creating visual and numeric output
reports and simulation movies

This lesson teaches you how to quickly navigate between these editors. To
make this lesson a little more interesting and useful, we’ll use the current case
to illustrate the various HVE-2D editors. Continuing from the previous
discussion, we’re in the Playback Editor. Let’s switch to Vehicle mode.

+ NOTE: Switching to Vehicle mode is synonymous with

selecting the Vehicle Editor.

Switching editors is performed using the Mode Selector located at the left hand
side of the toolbar (refer to Figure 32-5). To switch to Vehicle mode:

â Press the Mode Selector’s Vehicle pushbutton. The Vehicle

Editor is displayed with the current vehicle, Plymouth Voyager

Van, selected in the Active Vehicles list and displayed in the

Vehicle viewer, as shown in Figure 32-9.

Next, let’s display the Environment Editor. To switch to Environment mode:

â Press the Mode Selector’s Environment pushbutton. The

Environment Editor is displayed with the current environment,

Untitled Environment, displayed in the Environment viewer,

as shown in Figure 32-10.

+ NOTE: There is no Active Environments list, because

there is only one environment.
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Switch to Event mode:

â Press the Mode Selector’s Event pushbutton. The Event Editor

is displayed with the current event, EDSVS, Untitled Event,

displayed in the Active Events list and displayed in the Event

viewer, as shown in Figure 32-11.

Switch to Playback mode:

â Press the Mode Selector’s Playback pushbutton. The Playback

Editor is displayed and several reports are displayed, as shown

in Figure 32-12.

+ NOTE: The Playback Editor displays all selected reports.

This allows you to compare results from several events.
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Figure 32-9 Vehicle Editor with the active vehicle, Plymouth Voyager Van , displayed in
the Vehicle Viewer.
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Figure 32-10 Environment Editor with the current environment, Untitled Environment,
displayed in the 3-D viewer.

Figure 32-11 Event Editor with the current event,EDSVS, Untitled Event, displayed in the
3-D viewer.



Switch back to Vehicle Mode:

â Press the Mode Selector’s Vehicle pushbutton.

The Vehicle Editor is displayed with the current vehicle. Let’s change the
current vehicle:

â Choose Ford F-150 Fleetside in the Active Vehicles list. The

chosen vehicle becomes the current vehicle and is displayed in

the Vehicle viewer.

Let’s take a look at Ford F-150 Fleetside‘s basic vehicle attributes (Driver
Location, Engine Location, Number of Axles, Drive Axles):

â Click on the Object Info button on the toolbar. The Vehicle

Information dialog for Ford F-150 Fleetside is displayed,

showing its basic attributes, as shown in Figure 32-13

â Press Cancel to remove the Vehicle Information dialog.
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Figure 32-12 Playback Editor with several report windows displayed on the desktop.



Switch to Environment mode:

â Press the Mode Selector’s Environment pushbutton. The

Environment Editor is displayed with the current environment

in the viewer.

Let’s take a look at the current environment attributes. These are displayed in
the Environment Information dialog. To display this dialog, perform the
following steps:

â Click on the Object Info button on the toolbar. The

Environment Information dialog is displayed, as shown in

Figure 32-14.

The Environment Information dialog is used for assigning physical event
information (sun position and gravity constant, for NASA engineers doing
Martian vehicle simulation).
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Figure 32-13 Vehicle Information dialog, displaying the current vehicle�s basic attributes.



The Environment Information dialog may also be used for assigning a
geometry file to drive on, as well as sky color and fog for visibility studies.

â Press Cancel to remove the Environment Information dialog.

Using Dialogs

HVE-2D has more than 200 dialogs for entering and editing information. All
HVE-2D dialogs have default information already assigned. Therefore, when
using a dialog, you are always editing existing default data.

Modal vs Modeless Dialogs

HVE-2D (and most other applications) use two different types of dialogs:
Modal and Modeless.

A modal dialog requires the user to complete an action by pressing OK or
Cancel before another action can be performed.
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Figure 32-14 HVE-2D Environment Editor, displaying the Environment
Information dialog. This dialog is used for assigning the primary environment
attributes, such as location and gravitational constant.



+ NOTE: You cannot make any other program selection

until you remove the modal dialog.

On the other hand, a modeless dialog allows you to enter and edit data in the
dialog, as well as to make selections from the menu bar and manipulate objects
in viewers while the dialog is still displayed.

Let’s explore the use of these dialogs. First, let’s look at a typical modal dialog:

â Click on File menu option and choose Open. The HVE-2D File

Selection dialog is displayed.

â Using the HVE-2D Mode Selector, choose Event mode.

Note that HVE-2D beeps. This happens is because the File Selection dialog is a
modal dialog. You cannot perform any other operations until the File Selection
dialog is removed, either by pressing the dialog’s OK or Cancel button.

â Choose Cancel. The File Selection dialog disappears.

â Choose Event mode. The Event Editor is displayed, and the

current event is displayed in the 3-D viewer.

Now, let’s look at a modeless dialog. The most important example is the
Position/Velocity dialog used by the Event Editor:

â Click on the Ford F-150 Fleetside in the Event viewer. The

Position/Velocity dialog for the current vehicle is displayed, as

shown in Figure 32-15.

+ NOTE: You can tell right away that the Position/Velocity

dialog is a modeless dialog because it does not have the

OK/Cancel buttons like a modal dialog.

Let’s get some practice using a modeless dialog:

â Place the mouse cursor in the Position/Velocity dialog’s X

coordinate field and change the value to -20.00 feet from -4.00

feet.

â Press the <Enter> key or the Apply button. The vehicle’s

position is updated.
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+ NOTE: Notice that nothing happened until you pressed

the <Enter> key! This is a big difference between modal

dialogs (with an OK button) and a modeless dialog:

Pressing OK on a modal dialog is like pressing <Enter>;

since a modeless dialog does not have an OK button,

you must explicitly press <Enter> for the value(s) in the

dialog to be updated.

+ NOTE: You can enter several values into the dialog, then

press <Enter> once to have all the values updated at the

same time. This can save some time when updating a

vehicle’s position, since HVE-2D re-renders the viewer

whenever the viewer’s contents change.
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Figure 32-15 HVE-2D Event Editor�s Position/Velocity dialog.



Using Viewers

HVE-2D uses viewers to display vehicles and the environment. Of course,
viewers are also used to visualize the motion of these objects during Event and
Playback modes.

HVE-2D’s viewers have many features that make it easy for the user to select
how the objects are displayed. In particular, the user can perform the following
viewer operations:

• Resizing the viewer

• Panning the contents in the viewer

• Zooming in and out

• Dollying in and out

• Changing the camera position

These operations are described below.

Resizing Viewers

The size of the viewer is controlled by the user. To resize a viewer, perform the
following steps (refer to Figure 32-16):

â Close the Position/Velocity dialog still displayed on your
screen. Be sure Show Key Results has been selected from the
Options menu.

â Click on the left edge of the Key Results viewer frame (note the
cursor changes shape) and drag it to the left. The viewer grows
in width.

â Click on the lower edge of the viewer frame and drag it down.
The viewer grows in height.

â Click on the bottom left corner edge of the viewer frame and
drag it to the lower left corner of the screen. The viewer grows
in both width and height.

Notice by resizing the Key Results viewer, we’ve covered up the Event
Objects List viewer. Perform the following steps:

â Click on the left edge of the Event Objects List to bring the
viewer to the top of the desktop.

+ NOTE: While viewers may be resized, dialogs normally

cannot.

Spend a few moments practicing resizing the viewers and bringing various
desktop objects to the top of the desktop.
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Panning

Panning involves moving the scene horizontally and vertically within the
viewer.

To pan the scene, perform the following steps:

â Confirm the viewer is manipulate mode (the current viewer

mode is set by clicking on the hand icon along the upper right

edge of the viewer). If necessary, click on the hand icon.

â Place the mouse cursor in the middle of the viewer.

â Press the middle mouse button and drag to the right. You may

also press the left mouse button while holding down the <Ctrl>

key to perform the same operation. The viewer contents are

dragged to the right, as shown in Figure 32-17.

â Press the middle mouse button and drag to the left. The viewer

contents are dragged to the left.

â Use the same procedures to drag the viewer contents up and

down.

Spend a few moments practicing panning the contents in the viewer.
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Figure 32-16 Using HVE-2D�s viewers. Click on any edge and/or corner to resize
the viewer. In general make your viewers nice and BIG!



Zooming In and Out

Zooming involves changing the lens of the virtual camera that HVE-2D uses
to display the objects in the viewer. The current zoom status and zoom slider
are located along the right end of the lower edge of the viewer.

To zoom in, perform the following steps:

â Click on the Zoom slider and drag the slider to the left. The

camera zooms in on the scene. This is analogous to changing

from a 50 mm camera lens to a 150 mm telephoto lens.

To zoom out, perform the following steps:

â Move the slider to the right. The camera zooms back away

from the scene. This is analogous to changing back to a 35 mm

lens.

Zoom back to the original camera state:

â Move the slider back to the left until the scene returns to its

original size in the viewer, as shown earlier in Figure 32-17.

Dollying In and Out

Dollying involves changing the camera position, moving it closer to, or further
away from, the object (just like in filming a movie scene). To dolly in and out,
perform the following steps:

â First confirm the viewer is in manipulate mode: Place the

mouse cursor in the middle of the viewer and press the

<Escape> key. The viewer switches modes, as indicated by

the icons along the upper right edge of the viewer.

â Press the mouse cursor in the middle of the viewer and press

<Escape> again, and again, and again... Note the viewer

toggles between Pick and Manipulate mode. Leave the viewer

in Manipulate mode.

+ NOTE: We’ve illustrated two equivalent methods for

switching viewer modes (clicking the viewer Mode icons

or pressing <Escape>. The method you choose is up to

you.

â Place the mouse cursor in the middle of the viewer.

â Press the left mouse button and drag down. The camera dollys

in, as shown in Figure 32-18.

â Place the mouse cursor in the middle of the viewer, press the

left mouse button and drag up. The camera dollys out.
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Figure 32-17 Panning the camera in a viewer.

Figure 32-18 Dollying the camera in a viewer.



Let’s use a different method to dolly in and out:

â Click the mouse cursor near the top of the Dolly thumb wheel
(located along the lower right edge of the viewer) and drag
down. The camera dollys in.

â Drag the Dolly thumb wheel up. The camera dollys back.

â Click on the Dolly thumb wheel and drag the mouse cursor to

the top of the viewer. The camera dollys waaaaaaaay back.

+ NOTE: We’ve just illustrated the thumb wheel’s range of
motion is not limited by its visible size.

+ NOTE: We’ve also illustrated you can dolly in and out
using direct manipulation in the viewer or using the Dolly
thumb wheel. These two methods are equivalent. The
method you use is up to you.

Use either method (direct viewer manipulation or Dolly thumb wheel) to dolly
back in until the vehicle returns to its original size.

+ NOTE: Both dollying and zooming appear to have the
same effect, that is, to make objects appear larger.
However, if you zoom in too close, the objects become
distorted just as if you were using a fisheye lens. For this
reason, we recommend dollying instead of zooming if
your goal is to get a close-up view.

Changing the Scale

The final task we need to learn about viewer manipulation is changing the current
display scale. This is a very important task because it allows the user to set the visual
display to a reference scaled based on a given “foot of environment model per inch of
screen display” (or meter per centimeter). This is extremely handy for those user’s
who use a transparency of a scaled aerial photograph or site drawing on the front of
their computer monitor as a quick means of setting-up events or comparing simulated
results to actual results. To change the display scale, perform the following steps:

â Select View, Set Camera from the main menu.

â Enter the value that you want to use for your scale in the data

field next to the word Scale.

â Press the Apply button to see the effects of your scale setting.

â If satisfied with your scale setting, press OK to close the Set

Camera dialog and continue working. Otherwise, change the

value entered for Scale and press Apply again.

+ NOTE: Changing the Scale value automatically adjusts
the vertical position Z of the camera. The Zoom value is
not affected by changes to Scale.
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+ NOTE: The value you enter for Scale should provide you
with the expected results on your display. However,
there may be some small discrepancies due to the brand
and model of your monitor.

As a final tutorial exercise, continue looking at various parts of the vehicle
using direct manipulation and a combination of panning (middle mouse or left
mouse + <Ctrl>), dollying (left mouse) and rotating (left mouse + middle
mouse or left mouse +<Ctrl> + <Shift>). Spend some time here! By mastering
the task of viewer manipulation, you will benefit every time you use HVE-2D.
In particular, you will be able to work faster, and you will be able to better
visualize your work.

Shutting Down HVE-2D

When you are finished working with HVE-2D, you will end your session by
saving your work and exiting HVE-2D. It is important to exit HVE-2D
gracefully because HVE-2D asks you to save your work if it has changed since
your last save, and because HVE-2D updates your configuration file so your
next HVE-2D session uses the same preferences and options you’ve selected
for use in the current session. HVE-2D also saves the current editor when you
exit; thus, when HVE-2D is next used, it will display the same editor you were
using when you last exited HVE-2D.

To shut down HVE-2D:

â Click on the File menu and choose Exit.

Because your work case file has changed since your last save, HVE-2D asks
you to save or cancel these changes.

â Choose No.

HVE-2D is shut down and you can now go have lunch.
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